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1 Introduction

The MLA skills tracker program has been developed to help project deliverers to be able to quickly
and consistently develop audits for the purpose of project monitoring and evaluation. The program
allows some simple before and after analysis to be reported and this is considered a minimum
standard by MLA. Additional analysis is encouraged and this can be undertaken by downloading the
data to Microsoft Excel.

2 Downloading the program

The program can be downloaded from the MLA website at:
www.MLA.com.au/????/??

3 Getting started

Double click on the MLA Skills Audit icon on either your desktop or the start menu. This will launch
the program and the opening screen will appear as below.

g1 MLA Practice Change Database

File  Window Help

morebeef

FROM PASTURES

Skills Tracker

MLA Practice Change Database

4 Establishing a new project

In order to create a new project, which can contain a number of Audits, click on the File button and
then New in the drop down menu. This will launch a dialogue box in which project data can be
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entered including the project name. It is recommended that a new project is created to house audits
pertaining to the same project.

The Background section allows you to enter information to provide participants undertaking an audit
with some general project information and reasoning for the audit process.

The Instruction section is used to provide background to the project and the information entered
here appears in the electronic audit.

The Audit Name can be added here. The audit name appears at the top of the audit as a title. It is
used for reference purposes.

The Thank you message appears at the end of the audit.

The first Section and Category of the new audit can be added here. These Section and Category
areas are detailed later however the Category function is used for grouping questions by similar
type, as an example “skills questions” whereas the Section function is used to separate groups of
guestions in the Audit, as an example in a pasture management audit they might be grouped by
“plant physiology” and “animal requirements”.

a5 Mew Project = | (E] | S

Project Mame:

Backaground:

Imstructions:

Audit Name:

Description:

Thank you message

First Categony Mame:

First Section Name:

Save Cancel

5 Adding an audit

The first audit is created when the dialogue box above is completed. To add additional audits to the
project simply click on the Audits tab followed by the Add tab. A dialogue box will then ask you to
name this second audit and will automatically store it in the open project.
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6 Copying an audit

In many instances with an auditing process we are looking for a change in knowledge, skills and
attitude. For this reason it is useful to be able to quickly copy the initial workshop audit as a
reference. This is done by clicking on the name of the audit you want to copy and then clicking on
the Copy button.

A dialogue box will appear and to make a copy of the audit click Save. A copy of the initial audit will
be saved and the filename will be “Copy of ...”. The file name can be changed by opening it and
clicking on the Edit button.

7 Adding categories

Categories are used to classify questions with a common theme for later analysis and reporting. An
audit associated with pasture management might have two categories called plant nutrition and
animal requirements.

To add a category simply open the audit that you want to add a category too and click the
Categories tab, then click the Add tab. A dialogue button will appear and the title of the category can
be added and saved.

8 Adding a section

Questions can be added in separate sections. When the audit is open and the question topic is
visible right click on the Question title. A drop box will appear which says Add section, click on this
and then fill in the details in the dialogue box.

9 Adding questions

A question is created by right clicking on the Section you want to add the question to and then
clicking on Add Question.
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= MLA Skills Audit
File  Help

- Projec
| Proge | Patcpans | it | Categes | Demogapnes|
o udt || Ssve Close Add Question
= Questions
=) [ - Description Section Category
g OLesrion . In which of the areas listed below migh... | Section Cashflow
Edit Section A chart of accounts is: Section Accounting Principles
Delete Section A cashflow budget does not: Section Accounting Principles
- B5 B4 Afam business has income of $500. o... | Section Cashflow
gg BS Anincrease in the livestock invertoryi... | Sectionl Accounting Principles
..Bg B& Which of the following is a varable co... | Sectionl Accounting Principles
B9 B7 F the business has income of $500, a ... |Section Cashflow
S;‘? B2 Abalance sheet is not? Section Accounting Principles
--B12 BS Abusiness has a capital value of $1.0... | Section1 Cashflow
) S::i B10 Which of the following would not be c... | Section1 Debt Managemert
- B15 Bi1 Which of the following appears to be a... | Section1 Livestock Management
- B18 B12 A business has eamings before interes... | Section1 Cashflow
B13 The most appropriate use of a gross m... | Section Accounting Principles
B14 Abanks' lending margin is most comm... | Section1 Debt Management
B1& You are using debt effectively when? Section Debt Management
B16 The discount rate used in determining ... | Section1 Debt Management

T Instruction manual....

A dialogue box similar to the one above will then appear which will contain a number of cells which
can be added to. It is possible to allocate the question to a Category, give the question a number
and insert a picture or movie which can be used as part of the question.

The answer and its format are also added in this section. A drop box is provided for the answer type.
Only one answer type can be used for each question. The answer types are summarised by the
initials R C S N. A radio button (R) can only have one correct answer and as such will only allow one
answer to be ticked. A check box (C) can be used where there are multiple correct answers, a scale
(S) and numbers (N) are also available as options for answers.

Once the answer type has been assigned to the question it is possible to write the answers. This is
done by right clicking on Answer and then clicking Add Answer. A dialogue box appears and an
answer is typed into the Description section. This will appear in the audit as a possible answer. If it is
the correct answer the Correct Answer box should be ticked. When you have completed all the
answers the correct answer will be highlighted. It is important that where there is only one answer
that you have only one ticked.
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ol File Help

Project I Participantsl Audits |Ca‘tegories I Demogmphicsl

- Audit
[=- Questions
o Pudits

=E8

Save Close Add Question

Category Computers

CQuestion Number  Question

7] Include Cther
Other Label

Anzwer Type

Answer

10 Adding demographics

The demographics section is kept separate for the purpose of analysis. To add demographics click
on the Demographics tab and then the Add tab. A dialogue box appears which is similar to that for
adding questions. The information you are requesting, the demographic question, is added to the
Description section. The options that can be provided are again added like questions. The next step
is adding the option type the same as for adding questions. The same options appear and once
added it is possible to add the option by right clicking on the Options tab and then clicking Add

Option.
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B MLA Skills Audit - [Project]

ol File Help -
[ Projsct | Patticiparts | Audts | Categoriss | Demoaraphics |
© Add Edit Delete

Name Description
Pleass tick

How old are you?

What is your post cods?

What is your property area? n ha)

What area of your property is cropped? (in ha)

Wht number of cattls do you run an your property?
What are your plans for the nest 3-5 years?

What are the major limitations to business perfomance?

mnmzzzzzr

AR IR AR R

How confident are you as a business manager and understanding key profi diive...

: Save Cancel

11 Entering participants

In an open audit, click on the Participants tab and then click on the Add tab. A dialogue box will open
and information about each participant can be included. For the electronic version to operate at least
the name section must be completed and the email address added. The participant’s information is
uploaded by clicking on the Upload button. This means that the hotlink to the audit and code
required to complete the audit can now be sent to the participants via email.
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E¥ MLA Skills Audit - [Project]
W File Help e
Patcerts |t | Gaegrn [0

: Add Edit Delete Upload |

| Fist Name

12 Uploading projects

Once the audit has been created the project can be uploaded onto the server. This is done by
opening the appropriate project and then clicking on the Upload Project tab. Uploading the project
stores it on the server and allows other functions such as data storage and invites to be
accommodated.

13 Previewing the audit

In order to preview the audit click on the Audit tab, click on the name of the audit you want to
preview and then click on the Preview tab. You cannot edit the audit in this mode.

14 Printing hard copies

Where it is not possible to have participants fill in the audit electronically a hard copy may be
required. Participants can fill this out and the information can then be entered manually into the data
base by completing an audit on their behalf. To print a hard copy click on the Audit tab of the audit
you want to print, then the Print Preview button followed by the Quick Print icon.

15 Sending invites

To send the invites click on the Audit tab followed by clicking on the audit that you want to send out
invites for. Next click on the Send Invitations tab and invitations will be sent to the participants that
have been listed for that particular audit. An invite consists of a hotlink to the website containing the
audit and a code to enter which then matches the data collected through the audit process with the
participant details in the database.
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16 Completing the audit

Once the participants email address and code has been entered, a title page will come up on the
screen similar to that below. By clicking on the Start button the audit will commence by first asking
the demographics questions and then the audit questions. There is one question per page which
must be completed before the participant can move to the next. The participant moves to the next
question by clicking on the Next button after answering the question.

It is possible to have a humber of participants use the same email address. This can be particularly
useful when there are a number of people from the one business being evaluated. While the email
address can be the same the names must be different so that they can be individually identified.

ﬂ; https://mail.yam.com.au/MLA/default.aspx - Windows Internet Explorer =" Ll
£ -

ARl = tes /i yam.com.au . it oo o

File Edit View Favorites Tools Help

7 Favorites (& https://mail.yam.com.au/MLA/default.aspx

MLA SKkills Audit
m'a Online Assessment

HOME

Instructions

What to do? The questions are used to determine your level of understanding of

and financial it. All you need to do is tick the box
corresponding to the answer that you think is correct. If you don’t know please tick
*Unsure” rather than guessing. If you are unsure for all guestions that is fine as
you are at this workshop to increase your skills and knowledge.

Background

completion of the program to allow individuals to track their skill development. it will
aleo be used: Target the workshop content to your needs. Improve the content of
future workshops As part of the evaluation process for the project. Confidentiality
The information will be completely confidential and you will remain totaly

anonymous. Time It should take you between 10-15 minutes to complete the audit

Post Training Audit

This is the post training audit.

@ Internet | Protected Mode: Off ¥4 v |10% -

17 Downloading data

To download the data associated with a particular project first click on the Fill tab and then Open.
Next double click on the project that you want to download data for and then click on the Download
Results tab. The data will then automatically download to the server.

18 View results and Report

The results of the audit can be viewed in a simple report which brings together the results from the
pre and post training audits. The results are viewed by clicking on the Projects tab and then on the
View Results tab. This generates the screen below and offers the choice of reporting the audit or
demographics in either table or graphical format.
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@ File Help

Report Type Output
Audis -Categories () Dem - Categories/Audils Table

Graph

Wl File Help . & x
Report Type Output

) Audts -Categories @ Dem - Categories/Audis Table @ Graph

BEH 41 ofl b M |« @@ S EIQJ 100% - Find | Mext

Demographic Results r

Accounting Principles Debt Management Livestock Management

Initial Audit Initial Audit Initial Audit

F 100.00 50.00 100.00
CH 62.50 33.33 50.00
_ 100.00 100.00 100.00
_ 0 0.00 0
_ 100.00 100.00 100.00
N 0 0.00 0
E 25.00 0.00 0.00
R 25.00 0.00 0.00
0 0.00 0
100.00 100.00 100.00
100.00 100.00 100.00
0 0.00 0
10 | 100.00 100.00 100.00
0 0.00 0
20 | 100.00 100.00 100.00
E 25.00 0.00 0.00
10 | 0 0.00 0
B ] 100.00 100.00 100.00
EN 25.00 0.00 0.00
E 0 0.00 0

B MLA Skills Audit - ...

m

B R 20 pm
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8 MLA Skills Audit - [Reports] s
W File Help il
Repor Type Output
Open @ Audts -Categories () Dem - Categories/Audts ) Table (© Graph
EHIH 41 of1 b bl |« O SEDH | w00% - Find | Next

Category Results

Average %

0
Accounting Principles  Debt Management

Cashflow Livestock Manage ...

Category

Initial Audit
Post Training Audit

19 Downloading data to Excel

From the report screens described above it is possible to download the data to either Microsoft
Excel or Adobe PDF. This is achieved by clicking on the “disc” icon to view the drop down box and
then clicking either Excel or Acrobat (PDF) file.

@l File Help

Demographic Results

Accounting Principles

g eI
§ HEE

w

T} Instruction manual...

Bxcel
Acrobat (PDF) file

Debt Management restock Management

8 MLA Skills Audit - ...

L

-
Report Type Output
Open () Auds - Categories @ Dem - Categories/Audits @ Table () Graph
E W41 ofl b M |« @@ S E A 100% - Find | Next

T ) 319PM
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20 Saving and closing

The program offers the opportunity to save manually but in reality saving takes place as changes are
made. To correct a change you can right click to go Back one step.

To close the program down simply click on the cross in the uppermost right hand side of the screen
and the program closes.
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